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Description
This course covers the fundamentals of creating a 3D Model for existing features to include hard surfaces 
(i.e., asphalt, concrete, sidewalks, curbs, etc....), utilities, drainage structures, and soil borings.  Participants 
will be introduced to Bentley OpenRoads Designer Connect Edition - OpenRoads Technology tools for 
design and modeling; specifically for Florida Department of Transportation (FDOT) projects using the 
FDOTConnect10.12 WorkSpace.

Objectives

•	 Create and set up a GDTMRD file from Survey data
•	 Create and set up a ALGNRD file from Survey data
•	 Create and set up a MODLRD_ExistingFeatures file from Survey data 
•	 Create Shapes using FDOT’s Create Existing Features Tool
•	 Create Clipped Existing Feature Terrains
•	 Apply Surface Templates
•	 Edit Existing Feature Depth
•	 Add Curbs to the Existing Features
•	 Create and set up a RWDTRD file for Existing and Proposed Right of Way Lines
•	 Show Existing Right of Way Lines for Cross Sections
•	 Create and set up a MODLRD_ExistingUtilities file from Survey data
•	 Create and set up a MODLRD_ExistingDrainage file from Survey data
•	 Create and set up a ABORRD file for Geotechnical Data

Audience

•	 FDOT Roadway Designers and Engineers

Prerequisites

Participants should have a basic understanding of Computer Aided Drafting and Design (CADD) using 
MicroStation, a basic understanding of OpenRoads Designer Connect Edition - OpenRoads, Technology 
tools and a solid understanding of the engineering necessary to design a roadway.

Recommended: Basic knowledge of drawing tools, levels, details skills in MicroStation and understanding 
of the FDOT WorkSpace for Open Roads Designer and OpenBridge Modeler.  An overview of the essential 
elements of the FDOT design environment (CADD ESSENTIALS-Course Guide) as a prerequisite for this 
and other FDOT CADD training courses. Completing Bentley OpenBridge Modeler basic training courses for 
familiarity with tools and interface is also recommended.

For information about this and other CADD training courses, publications, videos, and Frequently Asked 
Questions, visit the Production Support CADD Office of the Florida Department of Transportation on the world-

wide web at http://www.fdot.gov/cadd/
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DOCUMENT STYLE
Style conventions used throughout the course guide are shown in the following table.

Item Convention Example
Menu names and com-
mands

Bold 

(Names separated 

with > symbol)

•	 General form is Workflow (when applicable) > Tab 
> Group > Tool

•	 File > Open
•	 File > Settings > User > Preferences
•	 OpenBridge Modeler (Workflow) > FDOT > Ac-

tions > Create File
Window actions Bold •	 Click the Apply button. 

•	 Click the Graphic Select button to the right of the 
Horizontal Alignment Include box. 

•	 In the Segment Type list, click Lines.
Window field names Italic •	 Key in Hemfield Road in the Alignment Name 

field. 
•	 Click the Graphic Select button to the right of the 

Horizontal Alignment Include field. 
•	 In the Segment Type list, click Lines.

Key-ins Bold •	 Key in Hemfield Road in the Alignment Name 
field.

File names Italic •	 Open the file Working Graphics.dgn in the C:\
Bentley Training\GEOPAK 101\Project Setup\Prac-
tice\ folder.

File paths Underline •	 Open the file Working Graphics.dgn in the C:\
Bentley Training\GEOPAK 101\Project Setup\Prac-
tice\ folder.

New terms or emphasis Italic or Bold •	 The Template Library contains templates, which 
represent typical sections of the proposed road-
way.

•	 The user is not to utilize this tool.
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1 CREATING A GDTMRD FILE

INTRODUCTION

This course was developed to introduce OpenRoads Designer Connect Edition - OpenRoads Technology 
tools for design and modeling on Florida Department of Transportation (FDOT) projects.  The curriculum 
was developed within the FDOTConnect10.12 WorkSpace to provide sample exercises for most of the 
new civil tools on a sample project data set.

OBJECTIVE

This chapter will introduce the OpenRoads Technology tools that will be used for exporting and importing 
the Existing Ground Terrain from the SURVRD file into a GDTMRD file that can be used for future modeling.

EXERCISE OVERVIEW
Exercise 1.1    Export the Existing Ground by Boundary.................................................................7
Exercise 1.2    Creating a GDTMRD file.........................................................................................9
Exercise 1.3    (Optional) Creating a Complex Terrain...................................................................12

Exercise 1.1 Exercise 1.1 	 Export the Existing Ground by Boundary 

1.	 Locate the FDOT 10.12 ORD  icon on the desktop and launch FDOTConnect10.12 for ORD.
2.	 From the FDOT WorkSpace, select the WorkSet 22049555201 and click the Browse button to navigate 

to the Survey folder.  Choose the file SURVRD01.dgn and click Open.
3.	 Zoom into the view and select the Terrain Boundary element.  Be sure to select the element with the 

level of DTM_ex and not the DTMBoundary_ep level.

NOTE      Issuing a left click and then multiple right clicks while hovering over the element will 
cycle through elements that might be stacked.
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4.	 Select the boundary and hover the cursor to display the context menu.  The third icon in the menu, 
Export Terrain Model allows the Terrain to be exported to several formats.  Choose the option LandXML.

NOTE      Alternatively, the pop-up menu export options can be found in the OpenRoads Model tab   
of Explorer.  Find the terrain under Terrains>Existing and right click on it. 

5.	 Fill out the dialog with the below information, and then click through each cursor prompt. 
 

                      
 

6.	 Save the file Existing Ground.xml into the project Survey folder. 
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Exercise 1.2Exercise 1.2  	 Creating a GDTMRD file 

1.	 Launch the Create File tool from the FDOT tab of the ribbon in the Actions group.  Switch the Discipline 
to Survey and the File Group to Survey Design Files.  Select the Base Filename GDTMRD from the 
list. Select a Coordinate System for the file or select a County which automatically populates the 
coordinate system dropdown.  Make sure all settings match the dialog below, and then click Create - 
Open File.  Close the Create File tool.

 

 

2.	 From the Terrain tab on the ribbon, locate the Create group and click From File to import terrain model 
data from a file.
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3.	 A dialog will open prompting for a file to import.  Select the Existing Ground.xml in the Survey folder 
and click Done.

4.	 This will open the Import Terrain Model(s) dialog.  Fill out the File Options with the information below, 
choosing DtmExisting for the Feature Definition and FL83/2011-NF for the Geographical Coordinate 
Systems.  Click Import and close the dialog.  Fit the view to see the imported Existing Ground terrain. 
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Exercise 1.3Exercise 1.3  	 (Optional) Creating a Complex Terrain 
 
 
Creating a Complex Terrain allows you to bring together multiple existing ground terrains into one, which 
is simpler to work with since the existing ground will often be the active terrain and changing the active 
terrain can break models and profiles.  It also allows you to easily update the terrain in the future should 
survey information change.  This makes it a useful tool even if only one terrain is added.  Different terrains 
can be added or removed from the definition of a complex terrain at any time, changing the terrain that 
most of the project design will depend on without breaking any dependencies or requiring recreating any 
models or profiles.

*Create a Null Terrain 

This portion of the exercise would not be necessary on a project with multiple existing ground terrain 
models.  For projects like this training dataset with only one terrain model provided, a null terrain must be 
created that can act as a placeholder and allow for the creation of a complex terrain.

1.	 From the Geometry tab of the ribbon, select Point in the Horizontal group. 

2.	 Match the values in the dialog below, and data point near the existing terrain to place the Null Point.
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3.	 Navigate to the Terrain tab of the ribbon and select From Elements in the Create group.  Fill out the 
dialog like below and select the Null Point that was just created.  Accept all cursor prompts to create 
the terrain.

        
 

	► Create a Complex Terrain 

In the next steps we will append the Null Terrain to the Existing Ground Terrain, making a new Complex Terrain.

4.	 From the Terrain tab of the ribbon, select Create Complex Terrain Model located under the Additional 
Methods drop-down in the Create group.

5.	 Set the Current Action to Append and add the Existing Ground terrain.  Next, add the Null terrain.  
Select DtmExisting as the Feature Definition and give it the Name Existing Ground Complex.  
Click Finish.
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NOTE      OpenRoads may give an unhandled exception somewhere around this point.  You can 
click continue and create the Complex Terrain.  ”Merge” discards information from 
the primary terrain model when terrains overlap.  “Append” keeps points from both 
terrains.  In this case, we created our null terrain from and keep information from our 
Existing Ground terrain, but this won’t work unless the Existing Ground is primary.  This 
shouldn’t make a difference if there is no overlap between terrains

If the Complex Terrain needs to be edited, navigate to it in Explorer under OpenRoads Model>Terrain 
Models and right click to choose Edit Complex Terrain Model.
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*Add a Boundary 

The complex terrain will likely triangulate beyond the boundaries of the original existing ground.  In the 
case of a project that has multiple disconnected terrains, this would be necessary to create one continuous 
terrain by triangulating between them.  Designers must remember not to rely on any elevation information 
from the complex terrain in these areas with extra triangulation. In this case, we can add a boundary to get 
the terrain to match the original.

6.	 On the Terrain tab of the ribbon, select Add Boundary under Boundary Options in the Edit group.

7.	 Set the Method to Extract Graphic.  Set the Feature Definition to Const Lines Red.  Set the Name to 
Original Existing Ground Boundary.  Select the Existing Ground terrain and accept all cursor prompts 
to create a line string for use as the boundary.

      

8.	 On the Terrain tab of the ribbon, select Add Features in the Edit group.

9.	 For the Terrain Model choose Existing Ground Complex.  For the Feature Type choose Boundary.  
Select the boundary shape and accept the cursor prompts to complete this exercise.
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NOTE      Once the Complex Terrain is created it can be used in any file that needs the Existing 
Ground set as the Active Terrain.
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2 EXISTING FEATURES

INTRODUCTION

This chapter will introduce the OpenRoads Technology tools to use for viewing the existing terrain and 
creating 3D existing features in design models in FDOTConnect10.12.  With the requirement to sign and 
seal backup calculations for earthwork, as well as more widespread use of the AMG (Automated Machine 
Guidance) by contractors, it is critical to create backup calculations (i.e., LandXML surfaces) for earthwork 
that closely match the cut/fill volumes.  Since contractor software cannot take in meshes, but only terrains, 
the terrains need to match meshes as closely as possible.

CIVIL TERRAIN MODELING

As defined in the Bentley Civil Tools help files:

“A terrain model is a set of three-dimensional triangles mathematically computed from point data collected 
on the surface being modeled.  Models are used to define highly irregular surfaces, particularly the surface 
of the earth, but can be generated for proposed surfaces, subsurface geotechnical layers, and etcetera.  
Terrain models are also referred to as digital terrain models (DTMs), triangulated irregular networks (TINs), 
or triangulated surfaces.

The MicroStation Terrain Model tools support importing and labeling terrain contours and spots on terrain 
models.  You can import a terrain model into a DGN to use its data.  Terrain models imported from the 
LandXML file format are supported within MicroStation.  However, any manipulation or importing from Civil 
products must be done within Bentley Civil.

Bentley Civil provides a robust set of tools to create, edit, analyze, and work with terrain models.

A terrain model is recognized as a MicroStation element type.  When you select a terrain model, the 
Element Selection tool Element Type tab indicates that it is a Terrain element type.”

Several terrain model civil features have been developed for the FDOTConnect10.12 WorkSpace to be 
used on FDOT projects.  Terrain elements created in the design file can be selected from these features in 
the various terrain model tasks.

WORKFLOW INFORMATION

Existing features will be created in a 3D model following the steps outlined in the exercises to follow.  When 
finished, the file will contain 3D existing features developed from the original existing DTM terrain and 
SURVRD01 files.  As a result of creating this file, any cross section created while the terrain elements are 
displayed in the 3D model will show existing features below the surface.
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Exercise Overview

Exercise 2.1	  Create and set up a ALGNRD file..........................................................................18
Exercise 2.2	  Create and set up a MODLRD_Existing Features file...........................................22
Exercise 2.3	  Create Existing Feature Shapes............................................................................24
Exercise 2.4	  Create Existing Feature Terrains (External)...........................................................27
Exercise 2.5	  (Optional) Creating a 3D Terrain Model Boundary by Active Profile......................29
Exercise 2.6	  Clip Internal Terrains..............................................................................................31
Exercise 2.7	  Apply Surface Templates......................................................................................33
Exercise 2.8	  Edit Existing Feature Depth...................................................................................35
Exercise 2.9	  Add Curbs to the Existing Features.......................................................................37
Exercise 2.10   View Existing Cross Sections...............................................................................43

Exercise  2.1Exercise  2.1  	 Create and set up a ALGNRD file 

1.	 The first step to set up an alignment file is to export geometry from the SURVRD file.  Open the file 
SURVRD01.dgn from the Survey folder of the 22049555201 WorkSet.

2.	 On the Home tab of the ribbon, open the Level Display from the Primary group and turn off all levels 
except BaselineSurvey.
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3.	 Navigate to the Geometry tab of the ribbon and select Export Geometry from the Import/Export drop-
down in the General Tools group.  Match the settings in the dialog below and select each Baseline 
SR61 & US98.   Accept all options and a prompt will appear asking for a location to save the .xml file.  
Name this .xml file Alignments.xml and save it to the Roadway folder.
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4.	 Launch the Create File tool from the FDOT tab of the ribbon in the Actions group.  Switch the Discipline 
to Roadway and the File Group to Roadway Design Files.  Select the Base Filename ALGNRD from 
the list.  Select a Coordinate System for the file or select a County which automatically populates the 
coordinate system dropdown. Make sure all settings match the dialog below, and then click Create - 
Open File.  Close the Create File tool.

5.	 On the Geometry tab of the ribbon select Import Geometry from the Import/Export drop-down under 
the General Tools group.  Choose the Alignments.xml file located in the Roadway folder and click Open. 
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6.	 On the Import Geometry dialog tick the box next to Alignment then click Import.  Use the Fit View tool 
located on the top of the view window to bring the imported elements into view.  These alignments will 
be used later to view dynamic cross sections.
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Exercise  2.2Exercise  2.2 	 Create and set up a MODLRD_ExistingFeatures file 

1.	 Launch the Create File tool from the FDOT tab of the ribbon in the Actions group.  Switch the Discipline 
to Roadway and the File Group to Roadway Design Files.  Select the Base Filename MODLRD from 
the list.  In the Modifier (Optional) field, type _ExistingFeatures.  Select a Coordinate System for the 
file or select a County which automatically populates the coordinate system dropdown.  Make sure all 
settings match the dialog below, and then click Create - Open File.  Close the Create File tool.

 

2.	 From the FDOT tab of the ribbon, select the Create Existing Features button under the Roadway 
group.  A prompt will pop up asking to attach a survey .dgn file, click OK and select the file SURVRD01.
dgn from the project Survey folder and click Open
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The FDOT Features tool attaches the survey file as a reference and copies elements required for existing 
features into the current file. 
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Exercise  2.3Exercise  2.3 	 Create Existing Feature Shapes 

The FDOT Features tool will assist in creating closed shapes to clip out terrains.  From left to right the tool 
contains a drop-down menu to select the Existing Feature, a Place Feature Line tool, a Create Feature 
Shape by Flood tool, and a Create Feature Shape by Trace tool.

1.	 In the drop-down list of the FDOT Features tool, select Pavement.  Notice that the tool automatically 
isolates the PavtAsphalt_ep level in the view.

 

2.	 Use the Place Feature Line tool to draw lines delineating the side streets to the northeast as well as 
closing off other ends of the US98 mainline.  For areas that have curves, a tangent snap helps to keep 
the linework from crossing over each other.
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3.	 Using the Create Feature Shape by Flood tool, click inside of the closed roadway mainline.  The tool 
will highlight  the shape and fit to view.  Click in the view to accept and create the shape.the shape 
and fit to view.  Click in the view to accept and create the shape. 
 
 

 
 
 

4.	 Repeat steps 1-3 to create closed shapes for the remaining existing features:

Driveways, Medians/Traffic Separators, Shoulders, Side Streets

Curbs do not use a shape and are instead created using a linear template, which is shown in a later 
exercise.  After all necessary clipping shapes have been created, Close the tool.
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Exercise  2.4 Exercise  2.4 	 Create Existing Feature Terrains (External) 

Once closed shapes are created, they can be used to create individual external or internal terrains with 
clipping tools.  External terrains are clipped from the existing ground, while Internal terrains are clipped 
from within External terrains.  Only one shape at a time can be clipped while using the External method.  
Multiple shapes can be clipped when using the Internal method.

The following Terrain features are included to assist in creating existing features on a project: 

1.	 Continuing in the file MODLRD_ExistingFeatures01, detach the reference SURVRD01.dgn. 

2.	 Attach the file GDTMRD01.dgn from the project Survey folder.  Click on the Existing Ground terrain 
element to get the context menu and choose the second option, Set As Active Terrain Model.  Key 
Ctrl+F to save settings. 

3.	 In the Default view make PavtAsphalt_ep the Active Level and turn off all other levels. 

4.	 On the Terrain tab of the ribbon select the Create Clipped Terrain Model tool under the Additional 
Methods drop-down in the Create group.
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5.	 Select the Existing Ground in the view as the Reference Terrain Model Element, change the 
Clipping Method to External, leave both Offset values at 0.00, choose DtmExistingPavement 
as the Feature Definition, and give it the Name US98_ExPavt_Temp.  Follow the cursor 
prompt to locate the Clipping Element, which is the mainline shape created in the previous 
exercise.  Accept each cursor prompt to complete the command and create the clipped terrain.  
The terrain is created in the Default-3D model and referenced back to the Default model. 
 

6.	 Press the F2 function key to open a plan view and 3D view side by side and view the resulting clipped terrain.

7.	 Repeat steps 3-5 for the remaining existing feature shapes (i.e., driveways, shoulders, medians/traffic 
separators, side streets)

NOTE      External clipping of US98 traffic separator should be done after the Internal Terrain is 
created in Exercise 2.6
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Exercise  2.5 Exercise  2.5 	 (Optional) Creating a 3D Terrain Model Boundary by Active Profile 

This exercise covers what to do in the event a clipped terrain triangulates outside of the shape boundary.

1.	 Select the Clipping Shape Boundary of the problem terrain.  On the context menu select Open 
Profile Model.  Open View 3 and click inside the window to display the profile of our shape.  Select the 
profile and choose Set As Active Profile. 
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2.	 From the Terrain tab on the ribbon, select the Add Features tool in the Edit group.  Change the Feature 
Type to Boundary.  In this example, SR61_ExPavt_Temp is used as the name of the Terrain Model.  
Select the profiled shape and accept the cursor prompts.  The clipped terrain Edge Method changes to 
From Boundary and is constrained to our original shape.

NOTE      If the terrain isn’t updating, select an option in the Edge Method drop-down.  This will 
force it to lock to the boundary.
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Exercise  2.6 Exercise  2.6 	 Clip Internal Terrains 

In some cases, the terrain created may include areas that they should not such as Traffic Separators, 
Medians, or Curbed Islands within a terrain created for a pavement area.  These smaller sections 
need to be clipped out of the larger terrain.  This is referred to as Internal Clipping.  The tool creates 
a new terrain with the area clipped out, it does not modify the existing terrain or the original 
terrain. In the next exercise, features will be clipped out of the US98_ExPavt_Temp terrain. 

1.	 In the Default view, key F9 to launch the References dialog and turn off the display of the reference 
MODLRD_ExistingFeatures01.dgn.  Change the Active Level to PavtAsphalt_ep and turn off all 
other levels. 
 

2.	 On the Terrain tab of the ribbon select the Create Clipped Terrain Model tool under the Additional 
Methods drop-down in the Create group.

3.	 For the Reference Terrain Model choose US98_ExPavt_Temp, for the Clipping Method choose 
Internal, leave both Offset values at 0.00, set the Feature Definition to DtmExistingPavement, and 
for the Name use US98_ExPavt.  Select the median and traffic separator shapes within the US98 
pavement shape as highlighted below, then follow each cursor prompt to create the new terrain.
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4.	 In the Default-3D view, select the US98_ExPavt_Temp and delete it.  The terrain that is left: US98_
ExPavt; should have punched out holes that match the internal clip shapes created previously.

NOTE      Alternatively, the external terrain can be deleted in Explorer from OpenRoads  
Model>Terrain Models.  If using this method, it is important to keep track of what name 
you have given your terrain, so the Internal terrain remains.

5.	 Repeat steps 2-4 on the SR61_ExPavt_Temp terrain and any other terrains with internal shapes.
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Exercise  2.7 Exercise  2.7 	 Apply Surface Templates 

In this exercise, a Surface Template will be applied to each of the existing terrains giving them depth.

1.	 Close the Default view and maximize the Default-3D view. 

2.	 On the Model Detailing tab on the ribbon, select the Apply Surface Template tool under the Surface 
Templates drop-down in the 3D Tools group.  For the Template, click the Ellipsis button to open the 
Pick Template dialog.  Under Existing Feature Templates, select PavementAsphaltExisting and click 
OK.  Leave the Feature properties as is.
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3.	 Following the cursor prompt Locate a Terrain Model, choose the US98_ExPavt and confirm the selection.  
Verify the surface template has been applied by hovering over the terrain and viewing the description.

4.	 Repeat steps 2-3 for each terrain selecting the appropriate Surface Template for each feature.  The 
menu option for applying surface templates is also available when selecting individual terrains.
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Exercise  2.8 Exercise  2.8 	 Edit Existing Feature Depth 

The surface templates that have been applied are set with a default depth.  In many cases, these depths 
may be acceptable.  If not, the value will need to be changed manually.

1.	 Key F2 to open both the Default & Default-3D views. 

2.	 Make the Default-3D view Active. 

3.	 Hover over the US98_ExPavt terrain and choose the third menu option Edit An Applied Surface Template 

 
 

4.	 The Editing Roadway Designer Template Drop dialog launches with the active template displayed. 
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5.	 Select the Active Template tab in the bottom left corner of the dialog and navigate to the EOP_
PvtThick item within the Parametric Constraints folder.  Right click the item select Edit… to edit the 
default parametric value.

NOTE      Alternatively, the surface template parametric values can be edited in Explorer from 
OpenRoads Model>Terrain Models.
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Exercise  2.9 Exercise  2.9 	 Add Curbs to the Existing Features 

In this exercise, existing curbs will be developed.  In order to use the civil tools to create the existing curbs, 
MicroStation elements will need to be changed to civil features.  Linear templates will be applied to the 
featured elements to generate the depth needed for curbs.

1.	 Key Ctrl+F1 to return to the Default view. 

2.	 In the Level Display, turn off all levels except CGBack_ep & PavtAsphalt_ep and use the right click 
menu to turn Off the display of the Default-3D reference.

3.	 Use the Element Selection tool to create a Selection Set of the CGBack_ep elements.



EXISTING MODELING 38

4.	 On the Geometry tab of the ribbon, select Set Feature Definition under the Standards drop-down in 
the General Tools group.  Change the Feature Type to Linear and set the Feature Definition to Curb 
Back Existing under the Existing Features>Curb folder.  Follow the cursor prompts to apply the feature 
definition to the curb elements.

 

 

   
 

5.	 Repeat steps 3-4 with the PavtAsphalt_ep elements, choosing a linear feature definition of Pavement 
Asphalt Existing.

6.	 Use the Open Profile Model tool on one of the CGBack_ep elements, choose view 3 and data point 
to view the Profile.  Choose the second option in the menu, Set As Active Profile.  
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7.	 On the Model Detailing tab of the ribbon, select the Apply Linear Template tool located in the 3D Tools 
group.  Choose the CGBack_ep element from the previous step.  Follow the cursor prompts and select 
the template CurbExisting (Stripping) under the Existing Feature Templates folder of the template 
library.  Match the settings in the dialog below, and make sure the Reflect Option is sweeping the shape 
towards the edge of pavement.  Accept all options to begin building the existing curb.  Press F2 to view 
the curb inside the 3D model.
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8.	 Locate the Corridor handles of the linear template and select Add Corridor Reference from the third 
menu option Corridor References.  Follow the cursor prompts to select the adjacent Pavement Asphalt 
Existing element, then reset to complete.  The curb should stretch to the edge of pavement.
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9.	 Repeat steps 6-8 to model the remaining existing curbs.  Some fine tuning on the curb linework may 
be required such as creating complex elements, also stopping the template just short of the end of the 
line sometimes helps.
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Exercise  2.10Exercise  2.10 	 View Existing Cross Sections 

Once the Existing Feature Terrains & Curbs have been created, a dynamic cross section view can be used 
to verify the model data.  In this exercise, a baseline in the ALGNRD reference file will be used to create a 
dynamic cross section view.

1.	 Key Ctrl+F1 to return to the Default view, turn on all levels.  In the References dialog, turn ON the 
display of the MODLRD_ExistingFeatures01.dgn reference.  Attach the file ALGNRD01.dgn from the 
project Roadway folder. 

2.	 On the Corridors tab, select Open Cross Section View under the Dynamic Sections drop-down in the 
Review group.

3.	 Follow the cursor prompt and select the US98 Baseline.  Choose the Left & Right Offset, Station, and 
Interval values.  Open View 4 and click inside to display the Cross Section view.
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3 EXISTING ROW LINES
INTRODUCTION

These exercises will introduce the process of bringing in the existing ROW lines into the MODLRD file.

OBJECTIVE

In this chapter, a RWDTRD file will be created and set up using existing and proposed linework.  The file 
will be referenced to the existing features model to view the ROW lines within the model.

Exercise Overview

Exercise 3.1   Create and set up a RWDTRD file.........................................................................44
Exercise 3.2   View ROW lines in a cross section view................................................................48

Exercise  3.1 Exercise  3.1 	 Create and set up a RWDTRD file 

1.	 Open the BlankFile.dgn in order to access the FDOT tab to create a new file in the next step.

2.	 Launch the Create File tool from the FDOT tab of the ribbon in the Actions group.  Switch the Discipline 
to Roadway and the File Group to Roadway Design Files.  Select the Base Filename RWDTRD from 
the list.  Select a Coordinate System for the file or select a County which automatically populates the 
coordinate system dropdown.  Make sure all settings match the dialog below, and then click Create 
Open File.  Close the Create File tool.
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3.	 Key F9 to open the References dialog.  Attach the file RW22049555201.dgn from the project ROWMap 
folder.  Give this reference a Logical Name of ROW.

 

4.	 On the FDOT tab of the ribbon, select Copy Reference Levels under the Misc. Tools drop-down in the 
Actions group.  In the Available Levels list, select RWLine & RWLine_ep and click the arrow button to 
add them to the list of levels to process.  Click Copy and then Yes to confirm the operation.  Close the 
tool and Detach the reference file RW22049555201.dgn.
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5.	 Attach the reference file, reference in the GDTMRD01.dgn file from the project Survey folder and set 
the terrain active. 

6.	 Create a Selection Set of the RWLine_ep elements. 

7.	 Use the Set Feature Definition tool under the Standards drop-down in the General Tools group to set 
a Linear Feature of Right of Way Line Existing.

 

8.	 Select all elements on the level RWLine_ep.  On the Geometry tab, click Profile From Surface under 
the Profile Creation drop-down in the Vertical group.  Choose Right of Way Line Existing as the Feature 
Definition and leave all other values as defaults.  Accept all cursor prompts to profile the existing ROW lines. 
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9.	 Repeat steps 5-7 for the proposed ROW lines, choosing Right of Way Line Proposed as the Feature 
Definition.  Key F2 to view the results in the 3D view.
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Exercise  3.2 Exercise  3.2 	 View ROW lines in a cross section view 

1.	 Open the file MODLRD_ExistingFeatures01.dgn in the project Roadway folder.  Key F9 to open the 
References dialog.  Attach the file RWDTRD01.dgn from the project Roadway folder.  Open View 4, 
Cross Section. 

2.	 On the Corridors tab, select Open Cross Section View under the Dynamic Sections drop-down in 
the Review group. 

3.	 Follow the cursor prompt and select the US98 Baseline.  Choose the Left & Right Offset, Station, and 
Interval values.  Data Point inside View 4 to display the Dynamic Cross Section view.

NOTE      When using the Dynamic Sections Review tools, the Right of Way lines displayed 
may disappear if stepping through stations.  This is a known bug that only affects the 
dynamic view and will not affect cut cross sections.

 
 
 
 



EXISTING MODELING 49

4 EXISTING UTILITIES MODELING

INTRODUCTION

These exercises will introduce the workflow used to layout existing Utilities lines.  The Drainage and Utilities 
workflow will be used, and a SUDA & SUE database will be embedded into the file.

OBJECTIVE

A new MODLRD file will be created, and elements will be extracted from 2D and given features for 3D.  This 
will allow the Existing Utilities to be viewed inside of the 3D model.

EXERCISE OVERVIEW

Exercise 4.1	  Create and set up a MODLRD_ExistingUtilities file..............................................50
Exercise 4.2	  Use the Extract From Graphic tool........................................................................52
Exercise 4.3	  Show Existing Utilities in a Dynamic Cross Section..............................................53
Exercise 4.4	  Creating a Profile From Vvh Data.........................................................................54
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Exercise  4.1 Exercise  4.1 	 Create and set up a MODLRD_ExistingUtilities file 

1.	 Launch the Create File tool from the FDOT tab of the ribbon in the Actions group.  Switch the Discipline 
to Roadway and the File Group to Roadway Design Files.  Select the Base Filename MODLRD from 
the list.  In the Modifier (Optional) field, type _ExistingUtilities.  Select a Coordinate System for the 
file or select a County which automatically populates the coordinate system dropdown.  Make sure all 
settings match the dialog below, and then click Create - Open File.  Close the Create File tool.

2.	 Navigate to the Drainage and Utilities workflow.  On the Layout tab of the ribbon, select Place Node in 
the Layout group.  A message will appear prompting to embed files for a Drainage and Utilities project.  
Click Yes and the file will process.

NOTE        This action cannot be undone.  The files become permanently embedded into the dgn.

3.	 Key F9 to open the References dialog.  Attach the file GDTMRD01.dgn from the project Survey folder.  
Set the Existing Ground as Active.
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4.	 Select the Terrain and chose Set Active Terrain from the context menu. 

5.	 Key F2 to open both the Default and Default-3D views and repeat step 4 in the 3D view to filter the 
level display of the 3D survey reference. 

6.	 Key F10 to open the Level Display.  Select the SURVRD01.dgn reference and choose Filters from the drop 
down.  In the Name list, click on STANDARDS.UTEXRD to filter the level display of the 2D survey reference.

7.	 Key F2 to open both the Default and Default-3D views and repeat step 6 in the 3D view to filter the level 
display of the 3D survey reference. Use the Save Settings
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Exercise  4.2 Exercise  4.2 	 Use the Extract From Graphic tool 

1.	 On the Layout tab of the ribbon, select Extract From Graphic in the Layout group.

2.	 In the Extract Utilities From Graphics dialog, choose Selection for the Method, leave Use 3D Element 
Elevations? unchecked, use -3.00 for the Vertical Offset, leave Search Radius at 0.00, select Existing 
Water Main (Quality Level B) for the Feature Definition, choose 6” for the Description, select Water 
Manhole for the Node Feature (this is initially greyed out but becomes active after choosing a feature 
definition).  Select the NPW(B) element along US98 in the Default view. Accept the cursor prompts to 
create the utility lines.

3.	 Repeat step 2 for each existing utility line selecting the appropriate Feature Definition  and Node 
Feature. Key F2 to see the results in the 3D model.  If the size of the utility is incorrect, it can be updated 
in Link’s properties Description field under Feature.
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NOTE      OE features do not need to be modeled. 
Optional: Turn off SURVRD in both the default and default-3D models

  
Exercise  4.3Exercise  4.3 	 Show Existing Utilities in a Dynamic Cross Section 

1.	 Open the file MODLRD_ExistingFeatures01.dgn from the project Roadway folder. 

2.	 Use the References dialog and Attach the file MODLRD_ExistingUtilities01.dgn to the Default view. 

3.	 Switch to the OpenRoads Modeling workflow.  On the Corridors tab, select Open Cross Section View 
under the Dynamic Sections drop-down in the Review group.

4.	 Follow the cursor prompt and select the US98 Baseline.  Choose the Left & Right Offset, Station, 
and Interval vaues. Open View 4 and click inside to display the Dynamic Cross Section view. 
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Exercise  4.4 Exercise  4.4 	 Creating a Profile From Vvh Data 

Once the existing utilities have been created, Vvh data can be plotted into the model.  This exercise 
demonstrates the use of OpenRoads tools to incorporate utility locates.

Vvh information can be provided in different formats.  The most common formats are PDF documents and 
Excel spreadsheets as well as .dgn files. Whatever the format is, the goal of this exercise is to import that 
information in a useable manner.

The example file included will be a PDF document that needs data extracted from it.

1.	 Open the delivered verified utilities PDF 22049555201_VERIFIEDUTILITIES in the project Survey>eng_
data folder and examine the Vvh information. 

2.	 Launch Microsoft Word and open the PDF 22049555201_VerifiedUtilities.csv  Select Convert All to 
convert the document.  

NOTE      If you do not have software that can convert the PDF, manual copying and editing of the 
information may be required.
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3.	 When the document opens, highlight, and Copy the column information within the table. 

4.	 Open Microsoft Excel and Create a new workbook.  Right-click on the A1 cell and Paste the data using 
the option Match Destination Formatting (M).
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5.	 Append the applicable information from Row 2 into Row 1.  The data can be sorted by headers using 
the Custom Sort tool under the Editing tab.  Each utility will need to be sorted by the test holes that 
correspond to them.  The Left Offset values will need to have a minus sign”-“ appended to them.  The 
objective of this step is to organize the data by each utility which will help later when constructing the 
vertical geometry.  Save the file in the Roadway>eng_data folder as a CSV (Comma delimited) (*.csv) 
and name it 22049555201_VerifiedUtilities.csv.
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6.	 Continue in the file MODLRD_ExistingUtilities01.dgn.  Detach the reference SURVRD01.dgn from the 
Default & Default-3D views. Make the Default view active.  Attach the file ALGNRD01.dgn from the 
project Roadway folder.  On the Geometry tab of the ribbon, select Import Horizontal Points From 
Ascii File under the Import/Export drop-down in the General Tools group.  Follow the cursor prompt 
and select the US98 baseline.  Navigate to the Roadway>eng_data folder, change the file type to All 
Files (*.*) and select the file 22049555201_VerifiedUtilities.csv, then click Done.
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7.	 On the Import Horizontal Points from ASCII File dialog, click Create new Text Import Settings File.
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8.	 On the Create Text Import Settings File dialog, under the File Format options, change First line to import 
to the correspond with where your test hole data starts.  For this example, it is line 6.  Click Next to 
continue to the Columns options.  Uncheck all Column Delimiters boxes except Comma and select 
each appropriate column header choosing the Skip option for the last 3 columns.  What is most import 
here is the station and offset. Click Next and then Finish.

 



EXISTING MODELING 60

9.	 Save the file as 22049555201_VerifiedUtilities.xml within the project Roadway>eng_data folder.

10.	 For the Feature Definition choose ActivePoint and click Import.  Close the Import Horizontal Point 
from ASCII dialog. The imported points can be verified within Explorer.
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11.	 Open 2 Views Plan/Profile using a long right click in the Default view.  Click OK and select the existing 
WaterB_ep element closest to the alignment, then click into View 4.
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12.	 On the Geometry tab, select Profile Line Between Points tool under the Lines drop-down in the 
Vertical group.  Choose Centerline for the Feature Definition.
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13.	 Activate Civil Accudraw with the “Z” option from the Geometry tab under the Civil Toggles drop-down 
in the General Tools group. The first icon toggles on/off.

14.	 In the Default view, hover the cursor over the first imported point on the WaterB_ep line.  Key Enter 
to lock the Station and for the Z value, enter the Top Elevation Value from the excel spreadsheet 
22049555201_VerifiedUtilities.csv that corresponds with the utility line.  Data point to enter the Start 
Point.  Locate the next horizontal point and key in the elevation value for the next Vvh test hole, data 
point to enter the End Point.  Start the next line at the previous End Point.
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15.	 Once the profile lines are drawn, Microstation Modify tools can be used to manipulate the linework. In 
order for the profile to get picked up correctly, the end points of the utility line work must be within the 
node shape as close to the original profile line.  From there, the linework can be chained together with 
the Profile Complex By Elements tool on the Geometry tab, under the Complex Geometry drop-down 
in the Vertical group.  Choose Automatic for the Method and Centerline as the Feature Definition and 
set the newly created line as the Active Profile.

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

16.	 Repeat steps 11-15 to plot the remaining Vvh information.
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5 EXISTING DRAINAGE MODELING

INTRODUCTION

These exercises will introduce the workflow used to layout existing Drainage pipes and structures.  The 
Drainage and Utilities workflow in OpenRoads Designer will be used and a SUDA and SUE database will 
be embedded into the file.

OBJECTIVE

Demonstrate workflow of creating the Existing Drainage

Create a 3D Existing Drainage model

Use the Extract From Graphic tool

EXERCISE OVERVIEW

Exercise 5.1	  Create and set up a MODLRD_ExistingDrainage file............................................65

Exercise 5.2	  Use the Extract From Graphic tool........................................................................68

Exercise 5.3	  Show Existing Drainage in a Dynamic Cross Section...........................................71
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Exercise  5.1Exercise  5.1 	 Create and set up a MODLRD_ExistingDrainage file

1.	 Launch the Create File tool from the FDOT tab of the ribbon in the Actions group.  Switch the Discipline 
to Roadway and the File Group to Roadway Design Files.  Select the Base Filename MODLRD from 
the list.  In the Modifier (Optional) field, type _ExistingDrainage.  Select a Coordinate System for the 
file or select a County which automatically populates the coordinate system dropdown.  Make sure all 
settings match the dialog below, and then click Create - Open File.  Close the Create File tool.

2.	 Navigate to the Drainage and Utilities workflow.  On the Layout tab of the ribbon, select Place Node in 
the Layout group.  A message will appear prompting to embed files for a Drainage and Utilities project.  
Click Yes and the file will process.

NOTE        This action cannot be undone.  The files become permanently embedded into the dgn.

3.	 Key F9 to open the References dialog.  Attach the file GDTMRD01.dgn from the project Survey 
folder.  Set the Existing Ground as Active. 
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4.	 Attach the file SURVRD01.dgn from the project Survey folder. 

5.	 Key F10 to open the Level Display.  Select the SURVRD01.dgn reference and choose Filters from the dropdown.  
In the Name list, click on STANDARDS.DREXRD to filter the level display of the 2D survey reference.

 

6.	 Key F2 to open both the Default and Default-3D views and repeat step 4 in the 3D view to filter the level 
display of the 3D survey reference.
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Exercise  5.2 Exercise  5.2 	 Use the Extract From Graphic tool 

1.	 On the Layout tab of the ribbon, select Extract From Graphic in the Layout group.

2.	 In the Extract Utilities From Graphics dialog, choose Selection for the Method, use 0.00 for the Vertical 
Offset and Search Radius, choose Exist. Circular Pipes for the Feature Definition, and 18 inch for the 
Description.  Select ExMESS18RCP4S for Node Feature (this is initially greyed out but becomes active 
after choosing a feature definition).  Follow the cursor prompt to select the PipeCulvert_ep elements 
in the Default view.  Once an element is selected, the Use 3D Element Elevations? tick box becomes 
available, tick it to make it active.  Accept the cursor prompts to create the existing drainage pipes. 
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3.	 After the structures have been placed, the Nodes need to be rotated in order to align with the center 

of the structure.  Highlight one of the drainage nodes and select the triangular Rotation Handles and 
snap on the center line of the pipe 
 



EXISTING MODELING 70

  
  
  
  
  
  
  
  
  
  
  
  



EXISTING MODELING 71

Exercise  5.3Exercise  5.3 	 Show Existing Drainage in a Dynamic Cross Section 

1.	 Open the References dialog and Detach the file SURVRD01.dgn from the Default & Default-3D views. 

2.	 Open the file MODLRD_ExistingFeatures01.dgn from the project Roadway folder. 

3.	 Use the References dialog and Attach the file MODLRD_ExistingDrainage01.dgn to the Default view. 

4.	 Switch to the OpenRoads Modeling workflow.  On the Corridors tab, select Open Cross Section View 
under the Dynamic Sections drop-down in the Review group.

5.	 Follow the cursor prompt and select the US98 Baseline.  Choose the Left & Right Offset, Station, 
and Interval values.  Open View 4 and click inside to display the Dynamic Cross Section view. 
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6  GEOTECH DATA MANAGER AND 
REPORT OF CORE BORINGS SHEETS

INTRODUCTION

This chapter will introduce the FDOT tools to load Borehole data into the Geotech Data Manager and 
create 2D and 3D models as well as the Report of Core Boring Sheets needed for plans.

OBJECTIVE

Demonstrate workflow of importing data into the Geotech Data Manager.

Create 2D and 3D models for use in viewing Borehole data.

Create the Report of Core Borings Plan Sheets.

EXERCISE OVERVIEW

Exercise 6.1	  Create and set up a ABORRD file.........................................................................73
Exercise 6.2	  Review delivered GeotechDataSheetTemplate.xlsx spreadsheet.........................75
Exercise 6.3	  Import delivered Geotech Data Template into the Geotech Data Manager...........78
Exercise 6.4	  Place Boreholes tool to create 2D and 3D models of Geotechnical Data.............81
Exercise 6.5	  Create an Event Points List in the ALGNRD file.....................................................84
Exercise 6.6	  Create a RDXSRD file to show Borehole information in Cross Sections.................86
Exercise 6.7	  Use the Report of Borings tool to create the Report of Core Borings Sheet.........90
Exercise 6.8	  Create a Soil Survey Sheet for plans....................................................................94
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Exercise  6.1 Exercise  6.1 	 Create and set up a ABORRD file 

1.	 This is an optional step, only needed if the SR61_CL centerline feature is not present in the ALGNRD 
file. Open the file ALGNRD01.dgn  from the project Roadway folder. On the Geometry tab select 
Import Geometry from the Import/Export drop-down in the General Tools group. Select All Alignments.
xml in the project Roadway folder and click Open.

2.	 Select the SR61_CL tick box under the Alignment\Centerline tree and click Import.

 

3.	 Launch the Create File tool from the FDOT tab of the ribbon in the Actions group.  Switch 
the Discipline to Roadway and the File Group to Geotechnical Design Files.  Select the 
Base Filename ABORRD from the list.  Select a Coordinate System for the file or select 
a County which automatically populates the coordinate system dropdown.  Make sure all 
settings match the dialog below, and then click Create - Open File.  Close the Create File tool. 
 

 
 

4.	 Key F9 to open the References dialog.  Attach the file ALGNRD01.dgn  from the project Roadway folder 
and the GDTMRD01.dgn file from Survey folder.  Fit the view and set the Existing Ground terrain Active. 

5.	 Key F2 to open the Default and Default-3D views side by side.  Make the Default-3D view active and 
Attach the Default model of the ALGNRD01.dgn file from the project Roadway folder with a logical 
name of ALGNRD-2D.  Turn off the display of the ALGNRD01.dgn Default-3D reference.
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NOTES         In order to plot Boreholes in the Default-3D model, the 2D alignment must be referenced in.
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Exercise  6.2 Exercise  6.2 	 Review delivered GeotechDataSheetTemplate.xlsx spreadsheet 

1.	 From the FDOT tab, click Explore Directories in the Resources group.  Open the excel workbook 
GeotechDataSheetTemplate.xlsx to examine the contents.  This workbook can be modified per 
project.

NOTE     The Excel spreadsheet is just one way of importing data from a database or is used 
forthose that prefer to work in Excel.

 

 
 



EXISTING MODELING 76

2.	 The following are 7 tabs in the example spreadsheet that will need Geotech data entered in: Boreholes, 
Materials, BlowCounts, FluidLosses, SampleData, CoreData, Undisturbed.  The appropriate 
information depending on the Borehole Type will be filled out in the other tabs of the spreadsheet.  The 
DropdownLists tab will be ignored.

 
 

 
 

3.	 On the Boreholes tab, applicable information is filled in each column from left to right.  BoreholeType 
& Vertical Datum are dropdown lists, other columns will need to be filled in manually. 
 

NOTE      One type of location information needs to be input for the Geotech Data Manager to 
work. Each Borehole should only contain one type of location data (Station, State 
Plane, or Latitude/Longitude). If there is more than one type of location data for a single 
Borehole, the other location data with be recalculated when the Borehole symbol is 
placed in the drawing. The Column Headers must not be changed. Columns can be 
added, but the Geotech Data Manager will ignore them. 

4.	 On the Materials tab, Stratum information will be entered for each Borehole.  AASHTO, USCS, and 
SoilPattern are dropdown lists, other columns will need to be filled out manually.  The other tabs will be 
filled out if applicable.
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Exercise  6.3 Exercise  6.3 	 Import delivered Geotech Data Template into the Geotech  
Data Manager 

Included in the dataset is a pre-filled workbook containing the boring information to be plotted.  This 
workbook will be imported in the Geotech Data Manager (GDM) and an .xml file will be exported.

1.	 From the FDOT tab, launch the Geotech Data Manager from the Geotechnical group. 
 

2.	 Once the tool opens, click File>Import>Borehole Data Sheet and open the file 22049555201_
GeotechDataSheetTemplate.xlsx from the Geotechnical project folder.  The Borehole Navigator 
Sheet & SPT Sheet import options are considered legacy formats.

NOTE      The legacy import options require additional changes to the formatting, contact the 
CADD office for more information.
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3.	 There will be a Warning! message displayed when importing this file, click OK to ignore and see 
the borehole data.  Use the Add & Edit buttons to add a new borehole or edit an imported one.  
Spreadsheets are not necessary to create a borehole database since all options for creating boreholes 
are included within the Geotech Data Manager.  Click Save after making any changes.
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4.	 Click File>Save As and save the file in the Geotechnical folder appended with the FPID of the project 
22049555201_Boreholes.xml.  Close the tool
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Exercise  6.4 Exercise  6.4 	 Use the Place Boreholes tool to create 2D and 3D models of 
Geotechnical Data 

1.	 Make Default view active.  On the FDOT tab, select Place Boreholes In 2D Plan from the Geotech 
Tools drop-down under the Geotechnical group.  Select the Use Surface Elevation option and Existing 
Ground from the drop-down.  Click the Browse button to select the file 22049555201_Boreholes.xml 
from the project Geotechnical folder and click Open.

 

2.	 Once the file has been loaded, click OK to plot the boreholes in the Default view.

NOTE          The Use Elevation in Data option will use the supplied data or 0 if blank.
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3.	 Make the Default-3D view active.  On the FDOT tab, select Place Boreholes In 3D Model from the 
Geotech Tools drop-down under the Geotechnical group.  Select the Use Surface Elevation option 
and Existing Ground from the drop-down.  Leave all other values as default and click the Browse 
button to select the file 2049555201_Boreholes.xml from the project Geotechnical folder and click 
Open.  Click OK to plot the boreholes in the 3D model.
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4.	 Zoom into the view to examine the different layers of each borehole.
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Exercise  6.5Exercise  6.5 	 Create an Event Points List in the ALGNRD file
 

1.	 Open the file ALGNRD01.dgn from the project Roadway folder. 

2.	 Key F9 to open the References dialog.  Attach the file ABORRD01.dgn from the project Geotechnical 
folder. 

3.	 Create a Selection Set of the elements on the Core level.  From the Geometry tab, select Event Point 
List in the Common Tools group.

 
 

4.	 Follow the cursor prompt to locate the alignment SR61_CL.  Choose No for the cardinal points options. 
The Event Point List dialog with appear.  Click the first option Add List.  Name the list Boreholes 
SR61_CL and click OK.

 

5.	 Select the Boreholes SR61_CL list and click the option Add By Northing Easting. Reset in the view, 
then data point to accept.  The Event Point List is populated with the borehole location data and 
automatically saved.  Close the tool.
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Exercise  6.6 Exercise  6.6       Create a RDXSRD file to show Borehole information in 
Cross Sections 

1.	 Launch the Create File tool from the FDOT tab of the ribbon in the Actions group.  Switch the Discipline 
to Roadway and the File Group to Roadway Sheet Files.  Select the Base Filename RDXSRD from 
the list.  Select a Coordinate System for the file or select a County which automatically populates the 
coordinate system dropdown.  Make sure all settings match the dialog below, and then click Create - 
Open File.  Close the Create File tool.

2.	 Key F9 to open the References dialog and Attach the following files:
	 C:\WorkSets\FDOT\22049555201\Roadway\ALGNRD01.dgn 
	 C:\WorkSets\FDOT\22049555201\Roadway\MODLRD_Detail61.dgn
	 C:\WorkSets\FDOT\22049555201\Roadway\MODLRD_Mainline61.dgn
	 C:\WorkSets\FDOT\22049555201\Geotechnical\ABORRD01.dgn
	 C:\WorkSets\FDOT\22049555201\Survey\GDTMRD01.dgn 

3.	 Set the Existing Ground terrain model as Active.  Key F2 to open the Default & Default-3D views

4.	 On the Drawing Production tab, select Place Named Boundary under the Named Boundary drop-
down in the Named Boundaries group.

 
 

5.	 Select the Civil Cross Section mode and set the Drawing Seed to 11x17 Cross Sections.  In the Default 
view, select the SR61_CL alignment.  In the Event Point List drop-down, select the list Boreholes 
SR61_CL.  Tick the box Include Event Points Only and Create Drawing.  Accept the cursor prompts 
to place the named boundaries.
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6.	 Leave the default options on the Create Drawing dialog and click OK to create the sheets.  The 
sheets will process and drop into the last sheet model.  Verify borehole data on the cross sections. 
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7.	 On the FDOT tab of the ribbon, open the Geotech XSection Labeler from the Geotech Tools drop-down 
of the Geotechnical group.  The tool scans the file for drawing models to label.  Click Process to complete. 
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Exercise  6.7Exercise  6.7 	 Use the Report of Borings tool to create the Report of Core   
Borings Sheet 

1.	 Launch the Create File tool from the FDOT tab of the ribbon in the Actions group.  Switch the Discipline 
to Roadway and the File Group to Geotechnical Sheet Files.  Select the Base Filename RPTBRD 
from the list.  Select a Coordinate System for the file or select a County which automatically populates 
the coordinate system dropdown.  Make sure all settings match the dialog below, and then click Create 
- Open File.  Close the Create File tool.

 
 

2.	 On the FDOT tab of the ribbon, launch the Report of Core Borings tool from the Geotech Tools drop-down 
in the Geotechnical group.  Select the Browse button and navigate to the file 22049555201_Boreholes.
xml in the Geotechnical folder.  Select the Roadway (soil stratum number) option and click Create Report. 
 



EXISTING MODELING 91

 

NOTE     The Vertical Exaggeration value can be increased past 100% if the strata numbers aren’t 
fitting correctly.

3.	 On the Home tab, launch the Models dialog from the Primary group.  Open the model ReportOfBorings. 
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4.	 Key F9 to open the References dialog and Attach the file RPTBRD01.dgn.  Select the model 
BoreHoleSheet1 in the drop-down list and click OK.  Right-click the attachment and select the Move 
option to position the reference on the sheet.

5.	 Repeat step 4 with each BoreHoleSheet reference to populate the sheet.  Edit the sheet title and other 
information as nesccessary.
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Exercise  6.8 Exercise  6.8 	 Create a Soil Survey Sheet for plans 

1.	 Launch the Create File tool from the FDOT tab of the ribbon in the Actions group.  Switch the Discipline 
to Roadway and the File Group to Geotechnical Sheet Files.  Select the Base Filename SSUVRD 
from the list.  Select a Coordinate System for the file or select a County which automatically populates 
the coordinate system dropdown.  Make sure all settings match the dialog below, and then click Create 
- Open File.  Close the Create File tool.

 
 

 

2.	 On the FDOT tab of the ribbon, select the Linked Data Manager tool in the Actions group.  Click the 
first option Create new link, then click Create New from Template.  In the drop-down, select Sheets 
and choose Roadway Soil Survey, then click OK.
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3.	 Save the file as 22049555201_Soil_Survey.xlsx in the project Roadway>eng_data folder.  On the 
Worksheet drop-down select Sheet1 and click OK.  Position the cell on the sheet and Data Point to 
accept the placement. 
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4.	 Modify the source Excel workbook by right clicking the entry in the Linked Data Manager dialog and 
selecting the option Open Source.
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